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PED 5.1 (2006) 
Pedigree Drawing Software  
User Manual 

Abstract 
PED 5 Pedigree Drawing Software 
(Presented at the European Congress of Human Genetics 2005) 

PED is a fast interactive pedigree drawing software for Windows 98 (R) and above. PED was introduced at 
the ESHG Conference in 1997 and now has a continuously growing user community with researchers and 
clinicians in over 30 countries worldwide. PED complies with the "Recommendations for standardized 
human pedigree nomenclature" proposed by the PSTF (Bennet RL et al, Am J Hum Genet 56:745-752,1995). 
Apart from fully sizable printed output, pedigrees can be exported as Windows metafiles (WMF) to virtually 
any Windows Office or drawing program. 

Among other enhancements, PED 5 now can fetch family information from a data file with LINKAGE or 
CSV (comma separated values) format, where each line describes an individual by the pedigree ID, the 
individual's ID, the IDs of his/her father and mother, the gender, the phenotype or affection status, and any 
other data related to the individual (like haplotypes, or clinical characteristics). Imported pedigrees can 
virtually be of any size; also descendants with a second, third, or even tenth partner or any descendants of the 
probands' ancestors will be correctly displayed. Currently, marriage loops are not handled; they must be 
edited in the edit window. Pedigree charts can also be exported to these standard file formats. With each 
open/edit/save cycle, all IDs will be preserved. So pedigree data can easily be imported into a spreadsheet, a 
database, or further be used in linkage calculations or risk assessment. A demonstration program is available 
at www.medgen.de/ped. 

Standardized nomenclature 
PED complies with the "Recommendations for standardized human pedigree nomenclature" proposed by the 
PSTF (Bennet RL et al, Am J Hum Genet 56:745-752,1995): 
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Import pedigree from a LINKAGE or CSV file: 
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Interactive pedigree drawing 
PED provides two drawing windows:  

1. Input window  
2. Layout window  

Auto-drawing: the input window 
In Input mode all drawing is done by pressing one button  

Click on a symbol, press Ctrl+S, Ctrl+D, or Ctrl+U (or click on the appropriate button at the top of 
the window) to draw a child (son, daughter, unknown gender) with the partner chosen in the partner 
drop down listbox (top left). To add a "new" partner: choose the last partner in the partner list box. 
Ancestors: Click on button Ancestors to draw parents, grandparents, great-grandparents... of the 
consultants.  
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Right click on a symbol to enter text surrounding the symbol  
 

Change a symbol to one of the predefined (or one of hundreds of other possible) symbols. 
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Default symbols as well as their corresponding menu items may be edited by the user:  
 

Many display options are user-defined:  
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Export your pedigree from Input pane 
You may export your pedigree chart from Input pane as a *.PIP (Ped InPut), as a LINKAGE (*.TXT), or as a 
Comma Separated Values (*.CSV) file: 

Perfect layout: the edit window 
Paste your pedigree to the layout ("edit") window: 
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Add the legend automatically, fine tune the layout manually, and print your pedigree: 
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Getting started with PED 5 
 
System requirements  

(All trademarks contained herein are the property of their respective owners.)  
Windows XP or higher. 
Although not tested extensively, PED 5 should run on Windows 98 and above. 
RAM: PED5 has a very low memory footprint. In other words: If XP runs on your computer, PED5 
will have enough memory. Screen size and resolution: the higher, the better.  
And of course a printer, in case you like to have some printed pedigrees  

Download and install  
Locate Ped5Setup.exe at the download page (see link above). Download, locate PED5Setup.exe on 
your hard disk, and double click on it.  
The Setup wizard will guide you through the simple installation.  

Uninstall  
From the Windows Start button, select Program - PED - uninstall.  

 

Drawing in input mode 
After launching PED, the input window will be displayed: 

Both consultants are already drawn. The male symbol is selected by default.  

Now they should have a son and a daughter: simply press the buttons labeled Son and Daughter:
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Ooops - there should have been two sons and a daughter. 

Just select the daughter (using your mouse, point at the daughter, and click on it): 

When the daughter is selected: 

Simply hit the Del button on your keyboard, or select the appropriate menu item in the Input Window menu 
(Remember: we're still in input mode). Now confirm (answer Yes): 
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Again, the male consultant is selected by default. Now press the buttons labeled Son and Daughter:

Children with several partners 
The daughter should have two girls with one partner, and two sons with a second partner. 
Click on the daughter in the pedigree, and press the Daughter button twice. The father of the two girls will be 
drawn automatically. 

With the daughter still selected, choose 2. Partner from the partner dropdown list: 

Press the Son button twice: 
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Why not has another son with a third partner? Just select 3. Partner from the partner list box at the left top, 
and press the Son button. What about another daughter with a fourth partner? Just select 4. Partner from the 
partner list box, and press the Daughter button. This is the resulting pedigree: 
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(Just in case you are interested in animal breeding, and wonder how many different partners may be drawn: 

We could go on and on and on ...) 

Text and / or haplotypes around a symbol 
Now we would like to add some text for the male symbol just right of the selected woman: 
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Right click on the symbol. A dialog will open: 

Here you can change the symbol (open the Phenotype drop down list box). This is the same as selecting a 
symbol from the phenotype menu. Enter some text surrounding the symbol and below the symbol. Press the 
Help button for more information. 

Hint:  
The current labels are not very meaningful (Text1 .. Text4, M1 .. M18). You may want to edit these 
labels:  

Instead of Text2 you may enter Day of birth, or instead of M.. to M18 you may enter the names of the 
DNA  markers you are interested in.  
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Back to our member. We entered some text, and chose Phenotype 4: left filled:

Not very pretty. We should move the selected symbol to the right, and the last generation down some lines: 

Press [ALT]+D once, select (click at) one of the symbols in the bottom line, and press [ALT]+X. Or, select 
the appropriate menu item from above: 
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Although you can move members individually, it might be more convenient to change the default spaces 
between members. Select Options: 

In the following dialog you can adjust horizontal and / or vertical spacing. 

Pressing the More button will give you - well, just as you have already guessed - some more options: 

Just try the different options to get used to them. 
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Saving the pedigree structure from Input pane 
(Please do not miss this paragraph. This is really important)

When you start drawing a pedigree, you are in Input mode. In input mode, relations between all members of 
a family are displayed. Input mode represents a view of the "inner structure" of a family. 

This is in contrast to Edit (layout) mode: In the Edit window, each circle or each square is just what you see: 
a circle or a square. PED does no longer look at those symbols as members of a family - it is a matrix of 
lines, circles, squares, and some text. 

This is the window where you "fine-tune" your pedigree drawing: Add a legend, a title, more text, line(s) to 
separate the legend from the pedigree chart, and so on. Here you can draw every possible pedigree;
especially those situations that cannot be drawn in input mode, like (marriage) loops, or consanguinity. 

Drawings in Edit window cannot be re-imported into input mode 
Why? Just take a look at the following drawing: 

This portrait of Peddy PED has been made exclusively inside the Edit pane. You would not expect this one to 
be imported in the input window... 
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If you plan to use input mode with the same pedigree later on:  
Export the pedigree before you leave input mode. 
No problem: Just press the Export button in the button bar below the menu bar. A dialog will open: 

Choose PED Input (*.PIP) file, and save the pedigree. 

For a test, clear the input window (Menu Input Window -> Clear). Now press the Import button, and choose 
the PIP file you just exported. Everything should be like before - well, not exactly: 

A pedigree exported as a PIP, TXT, or CSV file does not save any layout information. Symbols, any text, IDs 
and so on are preserved, but not the extra space added between members. Just go back to the previous page to 
see how members can be moved in Input pane. 

Paste pedigree to the Edit (layout) window 
Now, since we know the difference between the input and edit mode, we can proceed to the edit window: 
Paste your pedigree from input to the edit window: 
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Confirm (press yes), and now you see your pedigree in the edit window: 

The Edit window basics 
Before we continue, let's take a closer look at the Edit window: 

Clear the Edit window: File menu -> New. We see a grid with empty cells. To minimize the grid:  

Edit menu -> Remove blank borders. 



19 

• In Input mode, you first selected a symbol in a cell in the input pane, and then an action (e.g., press 
the Son button).  

• In Edit mode, you select a symbol / a line in the symbol bar, and then click on the cell in the edit 
window, where the symbol / the line will be placed.  

Now select the white square in the top symbol row, and then click at the top left cell in the edit pane: 

Place a female symbol in the top right cell, and an "unknown" symbol in the center bottom row:  
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Now choose a "T" line, and place it between the two upper symbols: 

Click at the vertical line button, then inside the cell just above the "unknown" symbol: 
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This is our simple pedigree. Lines are just above the symbols. To tidy up the drawing press [Ctrl] + R, or 
select the appropriate menu item:  

This is the final simplest pedigree:  

In edit (layout) mode, you can only draw inside the grid. To add more cells: click just beside the grid where 
you need more cells. To delete a cell content: Select the empty button and click on the cell where you want to 
delete the symbol inside the cell:  
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The edit window is much like a spreadsheet 
In the following pedigree drawing the colors have been changed (Menu Edit -> Colors -> Background / 
Lines)

The symbols and lines have been drawn by 

1. a click at the appropriate (human or line) symbol in the two-rows symbol bar at the top of the window  
2. a click at a cell in the window where the symbol is to be placed  

Longer lines can be drawn by using Free lines (Menu Edit -> Draw Free Line) or pressing [Ctrl]+F). Now 
we want to insert an additional row just below the top row. 

Press [Ctrl]+A to select a row (or at least a complete cell of a row) 
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A cross hair cursor will be shown. To select the second cell in the second row:  

1. Move the cursor inside the first cell of the first row  
2. press the left mouse button, and with the mouse button still down  
3. move the cross hair cursor to the third cell in the third row  

Now the second cell in the second row is selected: 

To insert a row just above the selected cell: 
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Now there is an empty row just below the top row: 

We should re-connect parents and children: 

Press [Ctrl]+F to select Free lines drawing mode (or choose this menu item from the Edit menu) and place 
the crosshair cursor between the parents. Press the left mouse button. With the mouse button still down, 
move the mouse to the female child symbol, and release the mouse. 

Just like with a spreadsheet you can copy / cut / paste... 
Always select an area first ([Ctrl]+A) 
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... or insert / delete cells, columns, or rows 
(Again, select an area first ([Ctrl]+A)) 

Input and Edit window revisited 
By now you should have an idea how the two windows work 

• When you launch PED, you are in Input mode You select a (human) symbol (you cannot select a 
line), then an action (press a button)  

• In Edit mode, you first select a symbol from the symbol bar, then click at the cell in the window, 
where the symbol is to be drawn  

• You paste the pedigree from the input window to the edit window by 
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• You cannot re-import a pedigree from the edit window in the input window  
• You can edit a symbol, the surrounding text, arrows, deceased marker ... in both modes by right click 

on the symbol  
• You can switch between both windows by [Ctrl]+Q and [Ctrl]+W, or 

• Export / Import the family as / from a CSV, PIP, or LINKAGE file in input mode 
(press the Import or Export button, respectively  

• Save / open the layout in the edit window as a PED file. (Menu File-> Open or Save as ...) 

 

• Export the layout from the edit window as a WMF file that any office program can import 
(Menu File -> Save as ...; now enter SomeName.WMF)

Edit annotations 
We switch to Input mode ([Ctrl]+Q), and import the pedigree (press the Import button) we saved on page 3.
Now paste the pedigree to the Edit window:  
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In Edit window, press [Ctrl]+N, or select the appropriate menu item 

The annotation window opens. Enter some text. Select a relative font size, and an alignment relative to a cell: 

Press OK. Nothing happens ... Now click on the T button in the symbol bar: 
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The text you entered is treated as any other (human or line) symbol. You choose the T button to select a text 
just entered in the annotation window, and you click on a cell that will be the "container" for the text: 

Delete an annotation in the drawing 
Click on the empty symbol button (first column / second row) in the symbol bar. Click on the cell in the 
drawing where the "container" of the text is located. If you are unsure where this is, show all text containers 
(reverse these cells): 
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The cell containing the text is reversed: 

Now with the "empty" cell in the symbol bar selected, click on the reversed cell in the window: 

Press [Ctrl]+R to redraw, thus removing the remnants of the previously deleted text. 

Options in Edit and Input mode 
If you choose (in Input mode) Input window - Options - More ... or (in Edit mode) Screen - View, you get the 
following dialog: 
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These options should be rather self explaining. If in doubt, please press the Help button. 

Adding a legend 
You can add a legend manually: Click at the appropriate symbol in the symbol bar, click on the edit window 
to draw the symbol, right click on the symbol, and enter the appropriate legend. As an alternative, you can do 
it automatically:  

Now you get a , well, simple legend for a simple pedigree: 



31 

PED scans all symbols in the pedigree, and shows each symbol that is not white / empty. The legend text is 
taken from the phenotype menu. Since we previously chose "left filled" from the phenotype menu, this is 
what the legend will say: 

Now you can right click on this symbol to edit the legend text: 

This is the legend: 
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Consider editing input text labels and phenotype 
menu items 
... when data from pedigrees entered by different persons should be collected in a single database. 

This does not look like a big deal with this simple pedigree from above. But consider counseling cancer 
families. You can edit the phenotypes menu items as well as all corresponding symbols just as you like (for 
details take a look at the how-to resources). Then phenotype #4 is no longer "left filled" but, say, "HNPCC". 
And phenotype #26 may be not just "bottom left white", but a red symbol labeled "breast cancer", and so on. 
Even easier to change are the labels of the "Text and haplotypes" dialog:  

Then in the dialog no longer "Text 1" but a more meaningful "First name" or "day of birth" will be displayed, 
and instead of "M1", e.g, the name of the marker you used:  
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Now, when you right click on a symbol in the input or in the edit window, more meaningful labels for the 
input fields will be displayed: 

When these edited labels and phenotype menu items are made available to all PED users involved in the 
same investigation (even at different locations), they all can export their pedigrees, e.g. as a CSV file, where 
each family member has an unique ID (preserved even after multiple im-/exports), and all exported files 
carry the same kind of information in their respective columns.  

The file menu: Save the pedigree as an editable 
layout (PED) file or as Windows metafile (WMF) 
for import into a presentation or text program 
From the file menu select Save as... and enter the name of the pedigree. A file suffix of "PED" will it make 
editable in the edit window in PED. A file suffix "WMF" will create a Windows Metafile:  
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Enter the name of the pedigree. Please do not miss to enter the suffix (ped or wmf) as well: 

If you save as a Metafile, you may want to have a colored background: 
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Press OK. Now create a new text document (This is an example with OpenOffice.org), and insert a picture 
from file: 
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Finally, here is the metafile (it will work in MS Word, or in presentation programs like MS Powerpoint as 
well...), ready to be resized, from stamp to poster size. 

No need to mention... 
... PED can print pedigrees at any size on each paper size. It is nice to print a large pedigree in poster size - 
but most of the time you probably print a pedigree on your own office printer. PED uses always one sheet of 
paper, no matter what the paper size is. 
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Import and Export 

The most requested features are now available 
During the last years there has been a frequent request for only two new features: 

• Save and reload pedigrees from / into input pane  
• Export / import files in / from LINKAGE file format  

 

In input pane, three (only slightly different) file 
formats are available for import / export: 

1. PIP 
Ped Input file; a format only used by PED.  

2. TXT 
a text file in Linkage / GeneHunter file format; numbers ( e.g. DNA  marker values) separated by 
spaces; for linkage analysis and risk calculation  

3. CSV 
Comma Separated Values. Much like a linkage file, but strings may be included. Suited for import / 
export in / from a spreadsheet, or a database.  

 

Using the PIP file format 
In case you only want to save the pedigree for later re-use and modification in Input pane, just press the 
Export button: 
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A dialog opens: 

In the Windows file save dialog enter a more meaningful name than New.PIP, and save the file. For a test, 
erase the input window:  
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Confirm:  

A pedigree consisting only of the two consultants is displayed. Now press the Import button: 

In the Windows dialog that opens select your previously exported PIP file: 

The pedigree you import has no layout information. It uses the currently selected colors for background, 
lines, and text, as well as the relative font and symbol size, or the default distance between symbols. For 
details select Input Window -> Colors, or Options.
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In the imported pedigree we want to add some extra space between the two top members: 

With the female symbol selected, press [Alt]+D, or use the appropriate menu item: 

A pedigree, re-imported in the input window: 
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Export a pedigree as a CSV file 
1. Enter the pedigree that will be exported 
The following pedigree shall be exported as a CSV file: 
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Pre-requisites 
Launch PED.  

1. Adjust colors: Input Window -> Colors -> ...  
2. Edit Input Labels: Window -> Edit Input Labels 

3. You don't have to - just to give you an idea: In Edit Window (Ctrl+W), open the phenotypes template, 
and edit the symbol labels (for details see the how-to resources). Save as PED file. In Windows 
Explorer, rename PED to PHN, and import these phenotypes (Switch to input mode, menu Phenotype 
-> New Symbols ... ) 
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By now you should know how to draw the pedigree at top of this page. In short: In Input window (Ctrl+Q), 
start a new pedigree (Input Window - Clear), press the Son, Daughter, and Ancestor button, and select the 
appropriate symbols from the Phenotype menu. Right click at the male consultant, and enter the values 
displayed in the pedigree above.
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2. Export the pedigree from above 
Press the Export button, select CSV, and press Save: 

In the dialog that opens, edit the fields in the group panes numbered 1 to 6: 
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1. Enter a family name or ID: 

Not recommended, but still in use: Write family ID and personal ID, separated by "-", in a single 
column. If you want to, check the second box.  

2. The next columns are not editable:  

3. Do you want the number of the phenotype (= symbol) in the phenotype menu? In a linkage file, only 
0, 1, and 2 are allowed. For a CSV file, you can use all numbers from the phenotype menu.  

4. If you right click on a symbol, you can add some decoration, like an arrow, or draw a line across a 
symbol (deceased). You can export this as a number, where "1" means "has an arrow", "2" is 
"deceased", and so on. If you later re-import this CSV file, all decoration will be restored.  

5. You can have up to four labels surrounding the symbol. These will be the contents of the next 
columns:  
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6. There are also up to 18 rows /1 - 2 columns of text below the symbol. Normally your pedigree should 
not have more than 4 - 6 rows of text below the symbol. More important: Did you always use a single 
column of text below the symbol? For CSV files a single column is recommended.  

7. Should the columns have headers (that is, column names)? If you want to export each pedigree in an 
extra file, this would probably be the best. Use comma or tab as column separator, and better do not 
use text identifiers, until you really need them.  

8. You can restore the defaults for a CSV file output:  
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If you accepted the defaults (as you usually should do), press OK, and save the output:  

3. Test your results 
A double click at the file may open it in MS Excel: 

You can open it in OpenOffice.org Calc:  
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In OpenOffice.org Calc there is a one page import wizard: 

This will give you the same result: 
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Import pedigree from a CSV file 
1. CSV (comma separated values) file format 
You can import pedigrees from a CSV file.  

The first 5 columns in the CSV file must have the following format:  

» Family ID | Individual ID | Father ID | Mother ID | Gender «  

1. Family ID: Optional (can be omitted) | string or integer  
2. Individual ID: Mandatory | Unique integer > 0 (if you have Family ID-Individual ID separated by a hyphen in a 

single column, PED should recognize this)  
3. Father ID: Mandatory | integer >= 0  
4. Mother ID: Mandatory | integer >= 0  
5. Gender: 0 (unknown), 1 (male), 2 (female)  

The next two columns are optional.  

If present, they must follow these rules: 

• Phenotype or affection status: Integer 0..291 = unaffected, 2 = affected, 0 = unknown 
Up to 30 different phenotypes (= symbols) can be displayed automatically, according to the current available 
phenotypes in the input window (see Phenotypes menu). Phenotypes outside 0..29 will be treated as '0' 
(unknown).  

• 'Markers' like 'arrow', 'deceased' (these are not DNA  markers!) Integer 0..63 arrow = 1, deceased = 2, both = 
3, ...  Use this column if you export / import pedigrees from / to PED  

All other columns are totally optional 

• 0..4 subsequent columns with items that will be displayed around the symbol (from top left to right bottom)  
• All other subsequent columns - if any - in the CSV file will be displayed below the symbol, in one or two 

columns  

2. Imports that will work and those that won't: 
Some rules to obey 

• All pedigrees exported from PED's Input pane as CSV file can be re-imported - with one exception: 
If the consultants or probands (i.e. the first pair of symbols displayed in the Input pane) have no children, 
they cannot be recognized as partners. In a pedigree drawing in input pane (as well as in a linkage file), 
partners can only exist if they have at least one child in common. For an explanation please take a look at the 
CSV file format. (This will not be a problem if you export / import as PIP file)  

• Pedigrees that cannot be drawn interactively in PED's input pane also cannot be imported: 
e.g., pedigrees that harbor loops (two brothers marry two sisters, consanguinities)  
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• Members from a CSV file that cannot be entered in Input pane cannot be imported:  
e.g., the parents of a partner of a child of the probands. In the following pedigree, the probands are colored 
red, and the female "partner", whose parents cannot be imported, is yellow: 

Of course, these parents (and anything else) can easily be drawn in the edit pane:  

3. Import a pedigree from the CSV file shown at the previous page 
This is the CSV file opened in a text editor:  

family,ID,father,mother,gender,phenotype,arrow,Text 1,Text 2,Text 3,Text 4,M 1,M 2,M 3,M 4,M 5,M 6,M 
7,M8,0,1,5,6,1,8,1,John,Doe,12-12-1950,,HNCCP,50,D123-45-
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005,XYZ1,c.123G>T,c.456G>T,ABC1,c.333G>C, 
0,2,7,8,2,2,1,,,,,,,,,,,,, 
0,3,1,2,1,3,0,,,,,,,,,,,,, 
0,4,1,2,2,17,0,,,,,,,,,,,,, 
0,5,0,0,1,1,0,,,,,,,,,,,,, 
0,6,0,0,2,8,2,,,,,,,,,,,,, 
0,7,0,0,1,1,2,,,,,,,,,,,,, 
0,8,0,0,2,1,2,,,,,,,,,,,,, 

This is the same file opened in OpenOffice.org: 

Be sure that the file format follows the rules given above.

In PED input pane, press the Import button: 

In the File dialog that opens, enter as file type CSV, then choose the appropriate file:  
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After you press the Open button, the import wizard will be launched. The top pane of each of the 6 pages of 
the wizard - hopefully - contains all information you need to import a CSV file: This is the first page of the 
import wizard: 

This is page 5 of the import wizard: 
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This is the final page of the import wizard: 

After pressing the Finish button, here is the pedigree you got from this file:  
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Remember: Imported pedigrees know nothing about a "best" layout. To restore the pedigree from the 
previous page, you have to adjust background / line / text colors, and the distance between symbols. Also 
notice that import / export does not distinguish between the various kinds of arrows available in PED. If an 
arrow is imported, always the default arrow will be displayed. 
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Import / Export a pedigree from / as a LINKAGE file 
The LINKAGE file format 
Basically, the LINKAGE file format is the same as the CSV file format shown on the previous pages. But 
here the items are separated by spaces, in contrast to CSV (Comma Separated Values). 

The first 6 columns are  

1. Family ID  
2. Individual ID  
3. Father ID  
4. Mother ID  
5. Gender  
6. Phenotype or affection status: Integer 0..21 = unaffected, 2= affected, 0= unknown 

Phenotypes outside 0..2 will be treated as '0' (unknown).  

Following are 

7. Marker genotypes: Each marker is represented by two columns (one for each allele, separated by a space)  

All items are integers - individual IDs must be unique integers 

With PED, only columns 2 - 6 must be integers >= 0 

The family ID may be a string (or even omitted, if there is only one family in the file). The marker genotypes 
must be integers, if you use the data for linkage analysis. PED does not test whether these alleles are 
integers. 

Use CSV format whenever possible 
The original linkage file format uses space as an item separator. So does PED, if a pedigree is exported in 
linkage file format. CSV is more flexible when the pedigree information has to be imported in a spreadsheet, 
or in a database. Missing values will be recognized, and will pose no problem if a pedigree has to be re-
imported in PED.  

Examples from the web 
As soon as you import CSV or linkage files in PED that have previously been exported from PED, there is 
nothing special to consider. In real life, you probably have data that will not adhere strictly to linkage file 
format. Two examples taken from the web should show you how to avoid possible stumbling blocks. 

1. Rearrange columns in data files 
If you concentrate on linkage analysis you certainly have noticed the following examples:  
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The first one is taken from http://linkage.rockefeller.edu/soft/linkage/. Select chapter 2.7 Pedigree 
Information (PEDFILE), and scroll down to the very last example at this page (just beneath the line the 
following data refer to a larger pedigree, taken from a coronary heart disease study, in PEDFILE form :).

Here we are interested only in columns 1 (pedigree number), 2 (id number), 3 (father id), 4 (mother id), 8 
(sex), 10 (disease status). 
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Now copy data from screen (from the original web page - here we have only a PNG file) to a text file, 
replace spaces by commas, replace double and triple commas by a single one, save as CSV file, import in a 
spreadsheet program, delete all columns except those mentioned above, and save as CSV file again.  

This is the resulting CSV file: 
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We launch PED, press the Import button, use first five columns, and, as 'phenotype', column 6. 

This is the resulting pedigree:  

To adjust the lay-out, select Input Window - Options - (or [Ctrl]+O), More, a symbol and a font size of 99 %, 
press ID Position and choose top right, and close all dialogs.  

If you take a closer look at, say, members number 19 - 21, you will see that an unknown phenotype results in 
a "?" inside the symbol, and affected members are displayed as black circles or squares, depending on the 
current phenotype file. 

2. Missing links in data files 
Sometimes you will get a pedigree much smaller than expected. For an example, please take a look at 
http://hg.wustl.edu/info/linkage/dataprep.html.

Scroll down to the bottom of the page until you see the line .pre File (in 'pre-MAKEPED', or 'pre-LINKAGE' 
format). On the right side a small file is displayed: 
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Importing this file in PED will result in the following pedigree:  

Only 5 members imported. The IDs are at the top right position, so it is easy to discover the missing 
members: 

There are three more "founders" (no parents of their own) in this small pedigree, and two more members 
(103, 105) that are children of these founders (30,31,32). We do not know how they are linked to the 
members of the previously shown pedigree. We add a pair of grandparents (9 and 10), and mark members 31 
and 104 as their children: 
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On the right side we see the pedigree from above; on the left we have the newly added members. On top 
reside the grandparents: 

Finally, two rules of thumb 
1. If the imported pedigree is smaller than expected, there is probably a missing link between the members of a 

pedigree  
2. If the imported pedigree is higgledy-piggledy, a chaos of lines, circles, and squares, there is probably a loop or 

consanguinity in your data file. Break that loop, and your pedigree will be properly imported  
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Tutorial 

Here we want to re-create the pedigree we used for a tutorial several years ago. This time we will focus on 
the newly available features in PED 5: 
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As soon as you launch PED, you are in Input mode. The "consultants" are drawn, and the male member is 
selected; i.e., its symbol is reversed.  

 

Now we add two sons and two daughters: Press the Son button twice, then the Daughter button twice: 
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To add some text decoration like name, DNA  number and markers, right click at the (top) male symbol. A 
dialog opens: 

We can enter the strings to the input fields, but was it the first name that should go in the first field labeled  
Text 1, and the family name in Text 2, or vice versa? We can edit the field labels: Close the dialog (press 
Cancel). From the Window menu, choose Edit Input Labels, and overwrite the default labels.  



64 

If you plan to re-use these labels with other pedigrees, you may want to save them (Save as) as a TXT file, 
and re-open by pressing the Open button 

To close the dialog, press OK 

Right click on the top male symbol again. In the dialog the labels have changed. Enter the values. Before you 
press OK be sure to select Yes (both) in the frame both columns? 
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Why should you choose both columns when you obviously need only one for a hemizygote? 

It does not matter if you export your pedigree as a PIP file, or paste it to the Edit pane (Ctrl+W) to save it as a 
lay-out (PED) file. But later we plan to import our pedigree data in a spreadsheet, where markers are listed 
pair wise. So, if you need both columns for at least one pedigree member, you should choose both columns 
for every member. You may also choose to enter "0" values in the second column, if you plan to export as a 
linkage file, where items are separated ny spaces.  

This is the pedigree so far:  

Now we label the topmost female as deceased, as carrier, and enter her name. Right click on this symbol, and 
enter the appropriate values:  
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We click on the first son in the second generation. From the Pheneotype menu, select affected.

To mark this symbol as deceased, press [Shift]+click, i.e., press the Shift key, and while the key still down, 
click the left mouse button with the mouse pointer over this symbol. 

For the second male symbol, we use two keyboard shortcuts:  

1. select (click at) the second male symbol in the second generation.  
2. press [Ctrl]+2 (This is a shortcut for the phenotype menu from above: While the Ctrl key still down, 

press the "2" key at the top of your keyboard - not at the numbers at the right side).  
3. press Shift+Click (while the Shift key still down, click on the second male symbol in the second 

generation).  
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Right click at the first female symbol in the second generation, and enter the values:  

Right click at the second female symbol in the second generation, and enter "Hanna Test", "DNA  1214", and 
the DNA  markers 2/1, 3/2, 4/1, 4/3. You should have the following pedigree: 
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The symbols are too close to each other. We should increase the "horizontal spaces" between the symbols. To 
move only the currently selected member, we can select the appropriate menu item from the Input Window 
menu:  

But now we would like to increase the spaces "globally": Select Options from the menu above (or press 
[Ctrl]+O). The Options dialog will show. In the Horizontal input field enter 4, and close the dialog: 

Here we have "Anna" selected - the symbol is reversed: 
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By the way, did you notice that the pedigree drawing always uses the whole window, and the font and 
symbol size are adjusted automatically?

Anna has three sons: Fritz, Frank, and Karl. The first and the second son are affected. Select Anna, in case 
she is not selected. To draw the three children, we could press the Son button three times, or use [Ctrl]+S 
three times. And, of course, there is also a menu item available: 

Right click at each of the three sons, and enter the data. Be sure to select both columns: 

We did not have to enter the father of the three sons. He was drawn automatically, as soon as we entered the 
first son: 



70 

This is the pedigree with Hans selected. Now select (click on) Hanna:  

With Hanna selected, press the Daughter button and the Son button - or press [Ctrl]+D and [Ctrl]+S. Again, 
the father of the newly added children will be drawn automatically. Right click on all three new members, 
and add the data. When we enter Rita's data, we choose an arrow:  
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Your pedigree should closely resemble this one:  

Take a closer look at Otto and Karl: They are hemizygotes, but their markers are centered below the symbol. 
This is a hint that we did not select the "both columns" radio button. Right click at both symbols, and select 
the "both" radio button: 

With PED 5, both columns is selected as soon as you enter text in the second column of the dialog. With 
hemizygotes you have to manually choose the "both" radio button only if you export as a CSV file. If you 
do not export your pedigree as a CSV file, or export it only as a PIP file, it is up to you - no manual 
selection is necessary.
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We want to save our work so far. But - all items of the file menu are disabled: 

We are still in input mode. In input mode you cannot "save" your pedigree. Either you 

• export a pedigree,  
• or paste it to the edit window.  

We will use the export option at the next page 

Now we export our pedigree from the previous page: 
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Press the Export button. In the dialog that opens, select the first option (PIP file format). 

After you press Save, a Windows File Save dialog will open. 

If you are not interested in importing your pedigree data in a spreadsheet, or a database, always select PIP file 
format, and press Save. In the Windows File Save dialog enter a pedigree name (suffix PIP), and you are done. 

But we want to save our pedigree data in a spreadsheet. Again, press the export button. This time select CSV 
file format. A big dialog will open:  
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Enter a family ID (if you plan to import the data into a database, you will probably use an integer instead of a 
string), accept the following defaults, change the columns to a value of two, and the number of rows to five. 
We like to have headers exported, and use a comma as the default separator. 

Press OK. The well known Windows file save dialog shows. Accept, or change, the default file name, and 
save your CSV file 

Close PED. In your favorite spreadsheet program, open the previously saved CSV file 

 

Compare the results with the pedigree drawing at the top of this page.

Launch PED, and press the Import button. In the Windows file open dialog select the CSV file type, and 
enter the file name: 
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The import wizard opens. This is the first of 7 pages: 

The second page is most important, if your CSV file had not been exported from PED. Press next. 

On the next page, enter the number of the column containing the phenotype (affected / unaffected). Here, 
accept the default. Press Next.
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If the CSV file is a PED export, you probably did add arrows or other decoration after a right click on a 
symbol: 

This may be re-imported in PED: 
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The following columns contain text that should be displayed around the symbol: 

Finally the last page. Here we tell PED which columns are to be displayed below a symbol. We need 4 rows 
with 2 columns, starting with file column 12: 
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Here we are again... Probably you want to adjust spaces (Menu Input Window - Options)

Obviously we cannot print our pedigree in input pane. We paste the pedigree to the edit (lay-out) pane: 

The edit window is different from the input pane:  

• There is a grid where each cell may contain a symbol, a line, or text  
• At the top is a symbol bar (you can edit the default symbols by choosing Symbol Bar - Edit)
• On the edit window there are no longer any "family members" - only lines, circles, squares, and text  
• You cannot re-import a drawing from the edit pane into the input pane  
• To draw: click on a symbol in the symbol bar, then click on a cell in the drawing pane  
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For more information about the edit pane, please take a look at page 3 of Getting started

We want to add the labels for the DNA markers. 

In the annotation window, we enter the labels: 
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Now press the "T" button - the recently entered text is selected, and click at the cells marked by the arrows. 



81 

Enter the title 

Use a large font size, press OK, and press the T button. Click on the white space above the grid to add more 
cells at the top. 
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Click on the cell the green arrow points to to enter the text. 

Add legend: 

Then select Draw Free Line from the Edit Menu: 
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Click on the cell where the left green arrow points to, then drag the mouse to the second arrow: 

We can change colors... 

• save as PED file - if you like to continue editing the layout later on (use File - Open)
• save as WMF file - if you want to import the drawing in a text or presentation document  
• print the pedigree from stamp size to poster size (depending on the available printer)  

And always use Printer Setup for page orientation before you press Print 


